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WYNN Wizard 7.0 Quick Start Guide 

Overview 
WYNN Wizard 7.0 is a program designed to support reading, writing, and studying.  The program reads 

text aloud, allows the user to customize the display of information, and offers many tools for reading, 

writing, and studying.   

To Use 

Opening Program 

1. Click on the WYNN Wizard 7.0 icon   located in the AT folder on desktop to open the 

program.  

2. Sign in by adding your name in the sign in window or locating your name in the drop down box.   

3. Click OK.  

4. Note that your setting preferences will be saved under your name.  

How it is Organized 

Toolbars  

Four color-coded toolbars organize WYNN’s functions.  Click on the go to next toolbar icon   to 

toggle between the four toolbars.   

The blue toolbar has file management functions, the green toolbar contains options for reading styles, 

the pink toolbar contains study features, and the yellow toolbar contains writing features.  On all four 

color-coded toolbars there are four buttons that remain constant: Read, Switch to Read-Only Mode, 

Switch to Exact View, Open File List. 
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Four Common Buttons: Read, Switch to Read-Only Mode, Switch to Exact View, Open File List 

On all four color-coded toolbars there are four buttons that remain constant: Read, Switch to Read-Only 

Mode, Switch to Exact View, Open File List. 

 

Figure 1: Four Common Buttons on Every Toolbar-Read, Switch to Read Only 

Mode, Switch to Exact View, Open File List.  

Note the following directions assume you have either opened text to read or a document to write in.  

For information on opening or creating new documents, see the section “Blue Toolbar: File 

Management.” 

Using the Four Common Buttons and Features 

Reading feature 

To read your text aloud, click on the Read icon.  WYNN Wizard will highlight text as it reads your text 

aloud.  Note that once you have clicked on this icon, it transforms to a Pause icon.  To stop reading, click 

on the Pause icon.  To change reading settings, see the “Green Toolbar: Reading Styles” section.   

 

Figure 2. Read and Pause Buttons transform into one another when selected  

Writing feature 

To write in a document, click on the Write icon.  Place your cursor in the desired location and type.  

Note that editing can only be done in Text View.  Once you click on the Write icon, it transforms to a 

Read Only icon.  To turn off the writing feature and to prevent accidental editing, click on the Read Only 

icon.   

  

Figure 3. Write and Read Only Buttons transform into one another when selected  

Text View feature 

There are three basic views in WYNN: Text View, exact and split view.  Text view displays only the text 

(i.e., no images) and is the view that can be customized the most using visual presentation features on 
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the green toolbar.  Exact view displays a replica of the scanned page (i.e., exactly how your page looks in 

a book, including images).  Split view shows Text View on the top of the screen and Exact View on the 

bottom of the screen.   

To change the view between Text View and Exact View, click on the Text View or Exact View icon.  Note 

that the Text View and Exact View icons transform into one another when selected.  There is no button 

on the toolbar for split view.  To select split view, click on the View menu and select Split View.   

  

Figure 4. Exact View and Text View Buttons Transform into one another when 

selected.  

Viewing Open Files 

To view a list of open files, click on the File List button and a list of open files will appear along the left 

hand side of the screen.  To close the file list, click on the Red X in the upper right hand corner of the file 

list. 

   

Figure 5. File List button leads to File list display as shown above.  

Blue Toolbar: File Management 
Several file management tools are available on the blue toolbar including scan, new, open, close, save, 

save as, print, clean up, save to audio, book search, export current document to word, and open the 

web.  Each are discussed below.   
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Figure 6. Blue Toolbar with File Management Functions - Scan, Create a File, Open 

a File, Close this File, Save, Save As, Print, Document Clean -up, Save to Audio, 

Book Search, Export Document to Word, and Open the Web.  

To scan documents into WYNN, first configure the scanning workflow.  Click on the Acquire menu, then 

click on Workflow, and click on your desired workflow setting.  To begin scanning, click on the Scan icon.  

Choose your desired scanner from the Device Selection pop-up menu, then click OK.  It may take WYNN 

a few minutes to scan and process your document using optical character recognition (OCR).  While 

WYNN is working you will see a “Acquiring” in the lower right hand portion of the screen. 

 

Opening Files 

To open a new WYNN document, click on the New icon.  To open an existing WYNN document, click on 

the Open icon.  The Open dialog box appears, search for the file you wish to open and then click Open.  

WYNN can open several non-WYNN file types including Microsoft Word files, Portable Document Format 

(.pdf), text files, HTML files, rich text format files, and daisy/NIMAS files.   To open a non-WYNN file, 

select the file type you wish to open in the Files of Type menu located at the bottom of the Open dialog 

box.  Note that WYNN 6.0 uses a new file extension: .WYX.  WYNN can still open and use older WYNN 

files. 
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The close, save, save as and print options work the same in WYNN as the options work in Microsoft 

applications.   

OCR Clean up 

Click on the Clean-up icon to correct OCR errors that may have occurred in the document during 

scanning. This ensures that the document will both visually display and be read aloud correctly. 

Save to Audio File 

Save to audio allows you to convert text top .mp3 or wave audio files. Click on the icon to begin and 

select page range desired for audio conversion. Click OK.  Note that audio file will be created with your 

saved settings including preferred reading voice and speed.  
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In the next window, select the preferred file type and from the drop down menu and press save.   

 

Quick Book Search 

Search a variety of sources for books in electronic format. Use the Book Search feature to download 

books from Bookshare.org, Project Gutenberg, and the Baen Free Library. Select the book you want and 

WYNN will download it to your WYNN documents folder.  Note that for Bookshare.org you must have an 

account to download books. 

 

Export to Word Document 

Export an open WYNN document to Microsoft Word to utilize the formatting styles available in a word 

processor. 
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Go to Web 

WYNN offers some support tools when reading and researching on the internet.  Click on the Go To Web 

icon to open WYNN’s web browser.  You can search the internet as you would a regular browser, but 

you also can mask the screen, look up words in WYNN’s dictionary, highlight important text, extract your 

highlights into a separate WYNN document.  To exit WYNN’s web browser, click on the Close Page icon. 

 

Figure 7. Icons Available in Go To Web: Read, Move Forward, Move Back, Stop 

Loading Current Page, Reload Current Page, Go to Home Page, Search the Web, Go 

to Favorites, View History, Change Masking, Dictionary, Highlight Text, Extract 

Text, Open File List, and Close Web Page.  

Green Toolbar: Reading Styles 
The green Visual Presentation toolbar allows you to customize the audio output and the way documents 

appear on the screen. 

 

Figure 8. Green Toolbar with Visual Presentation Functions : Increase Text Size, 

Increase Line Spacing, Increase Word Spacing, Increase Margins, Change Color 

Combinations, Change Amount of Masking, Read Continuously or Non-

Continuously, Change Speed Rate, and Increase Pause After Sentences.   

Visual Settings 

You can customize the following visual display settings: font size, space between lines of text, space 

between words, margins, screen color, and masking.  Masking is a special tool that shades a portion of 

the document in order to emphasize the current line, sentence, or paragraph.  To change any of these 

settings, click on the associated icon which will cycle through several preset options.  Alternatively, you 

can adjust the visual settings by clicking on the Settings menu, then clicking on Visual Settings. 
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Options that change the appearance of text (size, line space, word space, and margins) as well as screen 

masking can only be changed in Text View, not Exact View.  You can change the appearance in Exact 

View by zooming in or out.  To zoom in within Exact View, press the CTRL and PLUS keys together and to 

zoom out, press the CTRL and MINUS keys together.  The color may be changed in both text and Exact 

View.  To do this, click on Settings, then click on Visual Settings, and check the Use Two Tone for Exact 

View box.   
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Audio Settings 

You can also change the audio output of documents using the green toolbar including the pace of text 

read aloud, the rate of speech and the length of pause between sentences.  Click on the Self-Pace icon 

and four options appear: continuous, by line, by sentence, by paragraph.  Select how much text you 

want WYNN to read to you each time you click the Read icon.  To change the rate and length of pause, 

click on the associated icon which will cycle through several preset options.  Alternatively, you can adjust 

the speech settings by clicking on the Settings menu, then clicking on Speech Settings.  In the Speech 

Settings menu, there are additional options for customizing the audio output including selecting 

different voices, using a different voice for emphasis (e.g. bold or italicized words), and selecting which 

items you would like read aloud (e.g. menus, toolbar buttons, etc.). 

 

 

Reading Style tools not found in Green Toolbar 

Skim Reading 

WYNN also has skim reading capabilities, which will read the first sentence of each paragraph to allow 

you to get a quick understanding of the document content.  To enable skim reading, press Shift+F2 or 

click on the Tools menu and select Skim Reading. 
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Hot Keys for Rewind and Forward 

WYNN has hot keys to rewind and fast forward while reading text.  While reading, press the Left Shift 

key to rewind by sentence.  To fast forward by sentence, press the Right Shift key. 

Reading MathML Content 

WYNN can read aloud math and science formulas written in MathML.  Open the document containing 

MathML in WYNN’s web browser.  To read the formulas aloud, right click on them.  

Pink Toolbar: Study Tools 
The pink Study Tools toolbar allows you to access several study features including a talking dictionary, 

audible spelling, dividing words into syllables, highlighting text, extracting highlights,adding bookmarks, 

written notes and voice notes, and  creating notecards. 

 

 

Figure 9.  Pink Toolbar with Study Tools Icons: Open Standard or Basic 

Dictionary, Spell the Word, Syllabify the Word, Highlight Text, Extract 

Highlighted or Bookmarked Text, Insert a Bookmark, Create a Text Note, Create a 

Voice Note, Create a New Notecards Document, and Open a PAL Document.  

Dictionary and Spelling  

To look up a word in the dictionary, highlight or click the cursor on the word and click on the Dictionary 

icon.  A Dictionary dialog box opens and displays the definitions of the word.  Click Read to read aloud 

the definitions.  Click Switch to Synonyms to look up synonyms. 

WYNN will spell a word aloud if you highlight a word, then click on the Spell the Word icon.  To help 

pronounce words correctly, WYNN can break the word into syllables and read the word aloud 

phonetically.  Highlight a word and click the Syllables icon.  A dialog box will open showing the word 

broken into syllables and spelled phonetically.  Click Read Word to read the word aloud normally or click 

Read Phonetics to read the word aloud phonetically by syllable. 

Highlighting and Bookmarking Text 

The Highlight and Bookmark options allow you to mark passages in text for review and studying.  To use 

the highlight function, click on the Highlight icon and select a color of highlighter (cyan, green, magenta, 

orange, lavender or erase), then click and drag your mouse over the portion of text you wish to 

highlight. You can highlight items in a document in either Text View or Exact View.   

The bookmark feature works only in Text View.  To insert a bookmark, click and drag your mouse to 

highlight the portion of text you wish to mark, then click on the Bookmark icon and select a bookmark 
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symbol (red star, blue circle, green rectangle, or yellow triangle).  To erase highlights and bookmarks, 

select the text and then select the Eraser symbol on the Bookmark and Highlight icons.  To aid in 

studying, you can generate a list of all the text you highlighted or bookmarked in another document.  

Clicking on the Extract icon and select how you wish to arrange your bookmarks or highlights.  A pop-up 

window will open and guide you where to save your list of highlights or bookmarks.   

Text Note and Voice Notes 

WYNN allows you to insert written text notes or voice notes in Text View or Exact View.  To insert a 

note, place your cursor where you want the note to be located, then click the Note icon for a written 

note or the Voice Note icon for recorded voice note.  A dialog box will appear guiding you through the 

process.  When you have completed your note, a symbol will appear showing the location of the note.  

To review notes, double click on the note symbol or the voice note symbol in the text.  

Notecards 

WYNN allows the user to create notecards to organize their research and thoughts. Select the Notecards 

button to create a new notecard file. Notecards can be color coded within a deckby selecting from cyan, 

green, magenta, orange or lavender circles in the box that opens at the bottom of the screen.  

Notecards will be saved as WNC files. To open an existing notecard file, use the open button on the blue 

toolbar. 

PAL documents can be created by teachers to guide students with their studying, reading, writing, and 

comprehension.  Use the icon to open existing PAL documents.  

Yellow Toolbar: Writing 
The yellow toolbar contains a variety of tools for writing to increase comprehension, presentation and 

organization of your document.  Most writing tools can only be used in Write mode (not Read Only 

mode).Use the yellow buttons on this toolbar to cut and paste text, apply bold, italic, and underline to 

text, find text in the document, create and work with an outline, enable/disable Word Prediction, check 

for homophones, and check your spelling. 

 

Figure 10. Yellow Toolbar with Writing Tool Icons: Cut/Copy/Paste, Text Style 

Bold/Italic/Underline, Find/Replace Text, Go To Page, Create Outline, Outline 

Adjustments, Enable Word Prediction, Speak Word Prediction List, Homophones, 

and Spell Check.  

Cut/Paste and Styles 

The Cut/Paste icon allows you to copy, cut, and paste text in your document.  The style icon allows you 

to add bold, italics or underline to selected text.   
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Find Tool and Go to Feature 

The Find tool allows you to search your document for a specific word.  The Find feature also allows you 

to replace one word with another throughout your text.  The Go To tool allows you to navigate a 

document.  Click on the Go To icon, then select how you want to navigate the document (by page, 

bookmark, highlight, text note, voice note or any markup), then navigate your document by clicking 

either Next or Previous.  Note that the Go To feature is one of the few writing tools that can be used in 

Read Only mode and is useful for navigating documents you are reading as well as documents you are 

writing.   

Outline Feature 

To create an outline, click on the Outline icon.  WYNN will open a new document and will prompt you to 

create an outline.  Use the Adjust icon to change the level of text within your outline. 

Word Prediction  

WYNN can predict the words as you type which may help increase your writing speed, assist with word 

selection, spelling and grammar, and/or decrease the amount of typing required to write papers.  Click 

on the Predict icon and a pop-up window will appear displaying the words WYNN anticipates based on 

your typing.  To select a word from the prediction menu, you can either click on the word or press the 

function key (F1, F2, etc.) next to the word you want.  To have the word prediction menu read aloud, 

click on the Speak List icon. 

Editing Tools 

To review your written document for homophones (words that sound alike, but have different 

meanings), click on the Homophones icon.   A Homophones: Sound-alike Words dialog box will appear 

showing homophones in blue text, a list of potential confusable words and their definitions.  Your 

written document can be checked for spelling by clicking on the Spell Check icon.  If you prefer to have 

WYNN alert you to misspelled words as you type, click on the Tools menu, and then select Spell Check 

As I Type.  With spell check as I type selected, misspelled words will be displayed in blue.  To see a list of 

correctly spelled potential word choices, right click on the misspelled word. 
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Sending your Written WYNN Document to Microsoft Word 

After writing your document in WYNN, you may need to send it Microsoft Word for additional 

formatting or to send to others who do not have the WYNN program and therefore cannot open WYNN 

(.WYX) files.  See the icon on the blue toolbar export current document to word.   
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Program Manufacturer Contact Info 
Freedom Scientific, Learning Systems Group 

11800 31st Court North 

St. Petersburg, FL 33716-1805 

Phone: 800.444.4443 

Fax: 727.803.8001 

Website www.freedomscientific.com/ 

Cost:  
2013 pricing is as follows:  

WYNN Wizard: Reading, Writing, and Scanning (OCR) software: US $595 per license. 

WYNN Reader: Reading and Writing Software: $99 per license. 

WYNN can be ordered as either a stand-alone or network product. The network version of WYNN literacy software 
uses floating licenses. A school, educational institution or organization is allowed to install Network WYNN on as 
many workstations as they wish, but only the licensed number will be allowed to use the Network WYNN program 
at the same time. 

 

http://www.freedomscientific.com/

